This user’s manual contains useful information about the functions and operating procedures of the DataBrowser and lists the handling precautions of the software. To ensure correct use, please read this manual thoroughly before beginning operation. After reading this manual, keep it in a convenient location for quick reference in the event a question arises during operation.

Notes

• License numbers will not be reissued. Please keep your license numbers in a safe place.
• The contents of this manual are subject to change without prior notice as a result of continuing improvements to the software’s performance and functions. Display contents illustrated in this manual may differ slightly from what actually appears on your screen.
• Every effort has been made in the preparation of this manual to ensure the accuracy of its contents. However, should you have any questions or find any errors, please contact your nearest YOKOGAWA representative, dealer, or sales office.
• This user’s manual does not cover the handling and operating procedures of Windows.
• Copying or reproducing all or any part of the contents of this manual without YOKOGAWA’s permission is strictly prohibited.

Trademarks

• DAQWORX, DAQLOGGER, and DAQEXPLORER are registered trademarks or trademarks of Yokogawa Electric Corporation.
• Microsoft, Windows, and Windows Vista are registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
• Adobe and Acrobat are registered trademarks or trademarks of Adobe Systems Incorporated.
• Company and product names that appear in this manual are registered trademarks or trademarks of their respective holders.
• The company and product names used in this manual are not accompanied by the registered trademark or trademark symbols (® and ™).

Revisions

• 1st Edition February 2005
• 2nd Edition June 2007
• 3rd Edition January 2009
• 4th Edition June 2010
• 5th Edition January 2011
• 6th Edition October 2011
• 7th Edition June 2014
Software License Agreement

IMPORTANT - PLEASE READ CAREFULLY BEFORE INSTALLING OR USING:

THANK YOU VERY MUCH FOR SELECTING SOFTWARE OF YOKOGAWA ELECTRIC CORPORATION ("YOKOGAWA"). BY INSTALLING OR OTHERWISE USING THE SOFTWARE PRODUCT, YOU AGREE TO BE BOUND BY THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT AGREE, DO NOT INSTALL NOR USE THE SOFTWARE PRODUCT AND PROMPTLY RETURN IT TO THE PLACE OF PURCHASE FOR A REFUND, IF APPLICABLE.

Software License Agreement

1. Scope
This Agreement applies to the following software products and associated documentation of Yokogawa (collectively, "Software Product"). Unless otherwise provided by Yokogawa, this Agreement applies to the updates and upgrades of the Software Product which may be provided by Yokogawa. Software Product: DAQWORK (It is limited to each software that you bought).

2. Grant of License
2.1 Subject to the terms and conditions of this Agreement, Yokogawa hereby grants to you a non-exclusive and non-transferable right to use the Software Product on a single or, the following specified number of, computer(s) and solely for your internal operation use, in consideration of full payment by you to Yokogawa of the license fee separately agreed upon.
   Granted number of License: 1 (one)

2.2 Unless otherwise agreed or provided by Yokogawa in writing, the following acts are prohibited:
   a) to reproduce the Software Product, except for one archival copy for backup purpose, which shall be maintained with due care subject to this Agreement;
   b) to sell, lease, distribute, transfer, pledge, sublicense, make available via the network or otherwise convey the Software Product or the license granted herein to any other person or entity;
   c) to use the Software Product on any unauthorized computer via the network;
   d) to cause, permit or attempt to dump, disassemble, decompile, reverse-engineer, or otherwise translate or reproduce the Software Product into source code or other human readable format, or to revise or translate the Software Product into other language and change it to other formats than that in which Yokogawa provided;
   e) to cause, permit or attempt to remove any copy protection used or provided in the Software Product; or
   f) to remove any copyright notice, trademark notice, logo or other proprietary notices or identification shown in the Software Product.

2.3 Any and all technology, algorithms, know-how and process contained in the Software Product are the property or trade secret of Yokogawa or licensors to Yokogawa. Ownership of and all the rights in the Software Product shall be retained by Yokogawa or the licensors and none of the rights shall be transferred to you hereunder.

2.4 You agree to maintain the aforementioned property and trade secret of Yokogawa or licensors and key codes in strict confidence, not to disclose it to any party other than your employees, officers, directors or similar staff who have a legitimate need to know to use the Software Product and agreed in writing to abide by the obligations hereunder.

2.5 Upon expiration or termination of this Agreement, the Software Product and its copies, including extracts, shall be returned to Yokogawa and any copies retained in your computer or media shall be deleted irretrievably. If you dispose of media in which the Software Product or its copy is stored, the contents shall be irretrievably deleted.

2.6 The Software Product may contain software which Yokogawa is granted a right to sublicense or distribute by third party suppliers, including affiliates of Yokogawa ("Third Party Software"). If suppliers of the Third Party Software ("Supplier") provide special terms and conditions for the Third Party Software which differ from this Agreement, the special terms and conditions separately provided by Yokogawa shall prevail over this Agreement. Some software may be licensed to you directly by Supplier.

2.7 The Software Product may contain open source software ("OSS"), for which the special terms and conditions separately provided by Yokogawa shall take precedence over this Agreement.

3. Restrictions on Application
3.1 Unless otherwise agreed in writing between you and Yokogawa, the Software Product is not intended, designed, produced or licensed for use in relation to aircraft operation or control, ship navigation or marine equipment control, or ground facility or device for support of the aforesaid operation or control, or for use in relation to rail facility, nuclear related facility, radiation-related equipment, or medical equipment or facility, or under any other circumstances which may require high safety standards.

3.2 If the Software Product is used for the aforesaid purposes, neither Yokogawa nor Supplier assumes liability for any claim or damage arising from the said use and you shall indemnify and hold Yokogawa, Supplier, their affiliates, subcontractors, officers, directors, employees and agents harmless from any liability or damage whatsoever, including any court costs and attorney's fees, arising out of or related to the said use.

4. Limited Warranty
4.1 The Software Product shall be provided to you on an "as is" basis at the time of delivery and except for physical damage to the recording medium containing the Software Product, Yokogawa and Supplier shall disclaim all of the warranties whatsoever, express or implied, and all liabilities therefrom. If any physical defect is found on the recording medium not later than twelve (12) months from delivery, Yokogawa shall replace such defective medium free of charge, provided that the defective medium shall be returned to the service office designated by Yokogawa at your expense within the said twelve (12) months. THIS LIMITED WARRANTY PROVIDED IN THIS CLAUSE IS IN LIEU OF ALL OTHER WARRANTIES OF ANY KIND WHATSOEVER AND YOKOGAWA HEREBY DISCLAIMS ALL OTHER WARRANTIES RELATING TO THE SOFTWARE PRODUCT, WHETHER EXPRESSED OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR ANY PARTICULAR PURPOSE, NON-INFRINGEMENT, QUALITY, FUNCTIONALITY, APPROPRIATENESS, ACCURACY, RELIABILITY AND RECIENCY. IN NO EVENT SHALL YOKOGAWA WARRANT THAT THERE IS NO INCONSISTENCY OR INTERFERENCE BETWEEN THE SOFTWARE PRODUCT AND OTHER SOFTWARE NOR SHALL BE LIABLE THEREFOR. The warranty provisions of the applicable law are expressly excluded to the extent permitted.

4.2 At the sole discretion of Yokogawa, Yokogawa may upgrade the Software Product to the new version number ("Upgrade") and make it available to you at your expense or free of charge as Yokogawa deems fit. In no event shall Yokogawa be obliged to upgrade the Software Product or make the Upgrade available to you.

4.3 Certain maintenance service may be available for some types of Software Product at Yokogawa's current list price. Scope and terms and conditions of the maintenance service shall be subject to those separately provided by Yokogawa. Unless otherwise provided in Yokogawa catalogues or General Specifications, maintenance services will be available only for the latest version and the immediately preceding version. In no event will service for the immediately preceding version be available for more than 5 years after the latest version has been released. In addition, no service will be provided by Yokogawa for the Software Product which has been discontinued for more than 5 years. Notwithstanding the foregoing, maintenance service may not be available for non-standard Software Product. Further, in no event shall Yokogawa provide any service for the Software Product which has been modified or changed by any person other than Yokogawa.
5. Infringement

5.1 If you are warned or receive a claim by a third party that the Software Product in its original form infringes any third party's patent (which is issued at the time of delivery of the Software Product), trade mark, copyright or other intellectual property rights ("Claim"), you shall promptly notify Yokogawa thereof in writing.

5.2 If the infringement is attributable to Yokogawa, Yokogawa will defend you from the Claim at Yokogawa's expense and indemnify you from the damages finally granted by the court or otherwise agreed by Yokogawa out of court. The foregoing obligation and indemnity of Yokogawa shall be subject to that (i) you promptly notify Yokogawa of the Claim in writing as provided above, (ii) you grant to Yokogawa and its designees the full authority to control the defense and settlement of such Claim and (iii) you give every and all necessary information and assistance to Yokogawa upon Yokogawa's request.

5.3 If Yokogawa believes that a Claim may be made or threatened, Yokogawa may, at its option and its expense, either a) procure for you the right to continue using the Software Product, b) replace the Software Product with other software product to prevent infringement, c) modify the Software Product, in whole or in part, so that it become non-infringing, or d) if Yokogawa believes that a) through c) are not practicable, terminate this Agreement and refund you the paid-up amount of the book value of the Software Product as depreciated.

5.4 Notwithstanding the foregoing, Yokogawa shall have no obligation nor liability for, and you shall defend and indemnify Yokogawa and its suppliers from, the Claim, if the infringement is arising from a) modification of the Software Product made by a person other than Yokogawa, b) combination of the Software Product with hardware or software not furnished by Yokogawa, c) design or instruction provided by or on behalf of you, d) not complying with Yokogawa's suggestion, or e) any other causes not attributable to Yokogawa.

5.5 This section states the entire liability of Yokogawa and its suppliers and the sole remedy of you with respect to any claim of infringement of a third party's intellectual property rights. Notwithstanding anything to the contrary stated herein, with respect to the claims arising from or related to the Third Party Software or OSS, the special terms and conditions separately provided for such Third Party Software or OSS shall prevail.

6. Limitation of Liability

6.1 EXCEPT TO THE EXTENT THAT LIABILITY MAY NOT LAWFULLY BE EXCLUDED IN CONTRACT, YOKOGAWA AND SUPPLIERS SHALL NOT BE LIABLE TO ANY PERSON OR LEGAL ENTITY FOR LOSS OR DAMAGE, WHETHER DIRECT, INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES, OR OTHER SIMILAR DAMAGES OF ANY KIND, INCLUDING WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OR DESTRUCTION OF DATA, LOSS OF AVAILABILITY AND THE LIKE, ARISING OUT OF THE USE OR INABILITY TO USE OF THE SOFTWARE PRODUCT, OR ARISING OUT OF ITS GENERATED APPLICATIONS OR DATA, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, WHETHER BASED IN WARRANTY (EXPRESS OR IMPLIED), CONTRACT, STRICT LIABILITY, TORT (INCLUDING NEGLIGENCE), OR ANY OTHER LEGAL OR EQUITABLE GROUNDS.

IN NO EVENT YOKOGAWA AND SUPPLIER'S AGGREGATE LIABILITY FOR ANY CAUSE OF ACTION WHATSOEVER (INCLUDING LIABILITY UNDER CLAUSE 5) SHALL EXCEED THE DEPRECIATED VALUE OF THE LICENSE FEE PAID TO YOKOGAWA FOR THE USE OF THE CONCERNED PART OF THE SOFTWARE PRODUCT. If the Software Product delivered by Yokogawa is altered, modified or combined with other software or is otherwise made different from Yokogawa catalogues, General Specifications, basic specifications, functional specifications or manuals without Yokogawa's prior written consent, Yokogawa shall be exempted from its obligations and liabilities under this Agreement or law.

6.2 Any claim against Yokogawa based on any cause of action under or in relation to this Agreement must be given in writing to Yokogawa within three (3) months after the cause of action accrues.

7. Export Control

You agree not to export or provide to any other countries, whether directly or indirectly, the Software Product, in whole or in part, without prior written consent of Yokogawa. If Yokogawa agrees such exportation or provision, you shall comply with the export control and related laws, regulations and orders of Japan, the United States of America, and any other applicable countries and obtain export/import permit and take all necessary procedures under your own responsibility and at your own expense.

8. Audit; Withholding

8.1 Yokogawa shall have the right to access and audit your facilities and any of your records, including data stored on computers, in relation to the use of the Software Product as may be reasonably necessary in Yokogawa's opinion to verify that the requirements of this Agreement are being met.

8.2 Even after license being granted under this Agreement, should there be any change in circumstances or environment of use which was not foreseen at the time of delivery and, in Yokogawa's reasonable opinion, is not appropriate for using the Software Product, or if Yokogawa otherwise reasonably believes it is too inappropriate for you to continue using the Software Product, Yokogawa may suspend or withhold the license provided hereunder.

9. Assignment

If you transfer or assign the Software Product to a third party, you shall expressly present this Agreement to the assignee to ensure that the assignee comply with this Agreement, transfer all copies and whole part of the Software Product to the assignee and shall delete any and all copy of the Software Product in your possession irrevocably. This Agreement shall inure to the benefit of and shall be binding on the assignees and successors of the parties.

10. Termination

Yokogawa shall have the right to terminate this Agreement with immediate effect upon notice to you, if you breach any of the terms and conditions hereof. Upon termination of this Agreement, you shall promptly cease using the Software Product and, in accordance with sub-clause 2.5, return or irretrievably delete all copies of the Software Product, certifying the same in writing. In this case the license fee paid by you for the Software Product shall not be refunded. Clauses 2.4 and 2.5, 3, 5, 6 and 11 shall survive any termination of this Agreement.

11. Governing Law; Disputes

This Agreement shall be governed by and construed in accordance with the laws of Japan. Any dispute, controversies, or differences which may arise between the parties hereto, out of, in relation to or in connection with this Agreement ("Dispute") shall be resolved amicably through negotiation between the parties based on mutual trust. Should the parties fail to settle the Dispute within ninety (90) days after the notice is given from either party to the other, the Dispute shall be addressed in the following manner:

(i) If you are a Japanese individual or entity, the Dispute shall be brought exclusively in the Tokyo District Court (The Main Court) in Japan.

(ii) If you are not a Japanese individual or entity, the Dispute shall be finally settled by arbitration in Tokyo, Japan in accordance with the Commercial Arbitration Rules of the Japan Commercial Arbitration Association. All proceedings in arbitration shall be conducted in the English language, unless otherwise agreed. The award of arbitration shall be final and binding upon both parties, however, each party may make an application to any court having jurisdiction for judgment to be entered on the award and/or for enforcement of the award.

12. Miscellaneous

12.1 This Agreement supersedes all prior oral and written understandings, representations and discussions between the parties concerning the subject matter hereof to the extent such understandings, representations and discussions should be discrepant or inconsistent with this Agreement.

12.2 If any part of this Agreement is found void or unenforceable, it shall not affect the validity of the balance of the Agreement, which shall remain valid and enforceable according to its terms and conditions. The parties hereby agree to attempt to substitute for such invalid or unenforceable provision a valid or enforceable provision that achieves to the greatest extent possible the economic, legal and commercial objectives of the invalid or unenforceable provision.

12.3 Failure by either party to insist on performance of this Agreement or to exercise a right when entitled does not prevent such party from doing so at a later time, either in relation to that default or any subsequent one.

End of document
Overview of This Manual

Structure of This Manual
This manual consists of four chapters and an index as shown below.

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Before Using the DataBrowser</td>
<td>An overview of DataBrowser. Provides DataBrowser’s PC system requirements and configuration, flow of operations, and other information.</td>
</tr>
<tr>
<td>2</td>
<td>Operation of the Data Search Window</td>
<td>Describes methods to search for data files. Explains how to search by folder name, file date, extension, data type, characters, serial number, and other criteria; how to display search results; how to add channels to data; and other operations.</td>
</tr>
<tr>
<td>3</td>
<td>Operation of the Trend Display Window</td>
<td>Describes how to display data found during a search. Explains how to display waveforms, cursor values, and computed results; how to save settings and change data formats; and other operations.</td>
</tr>
<tr>
<td>4</td>
<td>Responding to Error Messages</td>
<td>Lists error messages, their causes, and their corrective actions.</td>
</tr>
<tr>
<td></td>
<td>Index</td>
<td>An alphabetical index of the manual's contents.</td>
</tr>
</tbody>
</table>

Scope of This Manual
This manual does not explain the basic operations of your PC’s operating system (OS). For information regarding the basic operations of Windows, see the Windows user’s manual.

Conventions Used in This Manual

- **Unit**
  
  K: Denotes 1024. Example: 100 KB  
  M: Denotes 1024 K. Example: 10 MB  
  G: Denotes 1024 M. Example: 2 GB

- **Bolded Items**
  Hardware and software controls that the user manipulates such as dialog boxes, buttons, and menu commands are often set in boldface type.

- **Subheadings**
  On pages in chapters 1 through 3 that describe operating procedures, the following subheadings are used to distinguish the procedure from their explanations.

  - **Procedure**
    Carry out the procedure according to the step numbers. All procedures are written with inexperienced users in mind; depending on the operation, not all steps need to be taken. Explanation gives information such as limitations related to the procedure.

  - **Explanation**

  - **Note**
    Calls attention to information that is important for proper operation of the instrument.
Contents

Software License Agreement .......................................................................................................................... ii
Overview of This Manual ............................................................................................................................. iv

Chapter 1  Before Using the DataBrowser
1.1 Overview of DataBrowser ....................................................................................................................... 1-1
   Functional Overview ............................................................................................................................... 1-1
   Diagram of Data Saving and Loading ....................................................................................................... 1-2
   Diagram of Data Searching and Display ................................................................................................. 1-2
1.2 System Requirements ............................................................................................................................ 1-3
1.3 Starting and Exiting the Software ......................................................................................................... 1-4
   Starting the Software .............................................................................................................................. 1-4
   Exiting the Software .............................................................................................................................. 1-4
1.4 Flow of Operations ............................................................................................................................... 1-5

Chapter 2  Operation of the Data Search Window
2.1 Names of Parts in the Data Search Window ........................................................................................... 2-1
2.2 Registering and Specifying Search Folders ........................................................................................... 2-2
   Registering New Search Folders ............................................................................................................... 2-2
   Specifying a Folder from the List ............................................................................................................. 2-3
   Registering a Folder from the Explorer ................................................................................................... 2-4
   Notes When Registering Search Folders ................................................................................................ 2-5
2.3 Specifying Search Conditions ............................................................................................................... 2-6
   Specifying a Date and/or Time Range ..................................................................................................... 2-6
   Specifying a File Name or Extension ....................................................................................................... 2-7
   Specifying Data Types ............................................................................................................................ 2-8
   Specifying Keywords .............................................................................................................................. 2-8
   Specifying a Serial Number ..................................................................................................................... 2-9
   Specifying Search Conditions ............................................................................................................... 2-10
2.4 Executing the Search ............................................................................................................................. 2-11
2.5 Displaying Search Results ..................................................................................................................... 2-12
   Displaying the Search Status .................................................................................................................. 2-12
   Narrowing the Search Results ................................................................................................................ 2-13
   Displaying File Details ........................................................................................................................... 2-14
2.6 Adding Channels from Search Results to the Trend Display Window ................................................... 2-16
   Collectively Adding a Selected Range of Channels .............................................................................. 2-16
   Adding Individual Channels .................................................................................................................. 2-16
2.7 Saving and Loading Search Settings and Results ................................................................................... 2-17
   Saving Search Settings ............................................................................................................................ 2-17
   Opening Search Settings from a Local Host ............................................................................................. 2-18
   Opening Search Settings from a Network Host ....................................................................................... 2-19
   Saving Search Results ............................................................................................................................ 2-20
   Opening Search Results from a Local Host ............................................................................................ 2-21
   Opening Search Results from a Network Host ....................................................................................... 2-22
2.8 Copying Data Files ................................................................................................................................. 2-23
Contents

Chapter 3  Operation of the Trend Display Window

3.1 Names of Parts in the Trend Display Window .............................................................. 3-1
Opening the Trend Display Window ............................................................................... 3-1
Display Channel Setting Screen .................................................................................... 3-1
Editing Functions in the Channel Display Configure Screen ........................................ 3-3
Waveform Display Screen ............................................................................................. 3-4

3.2 Selecting a Group for Adding Channels ...................................................................... 3-5
Adding and Deleting Groups ......................................................................................... 3-5
Linked Group Settings .................................................................................................... 3-5

3.3 Settings in the Channel Setup Screens ......................................................................... 3-6

3.4 Displaying Trends ........................................................................................................ 3-9
Displaying Waveforms of Different Intervals .................................................................. 3-11
Time Reference Mode ...................................................................................................... 3-12
Save Format of Displayed Data ....................................................................................... 3-12
Displaying Alarms ........................................................................................................... 3-13
Y-Axis Display ................................................................................................................ 3-13
Clip Function .................................................................................................................. 3-15
Trip Point ........................................................................................................................ 3-16
Copying the Trend Display ............................................................................................. 3-16

3.5 Displaying Cursor Values ............................................................................................ 3-17
Deleting Cursors ............................................................................................................. 3-18

3.6 Displaying Computed Results (Statistics) .................................................................. 3-19

3.7 Saving and Loading Trend Settings ............................................................................ 3-20
Saving Data Trend Settings ............................................................................................. 3-20
Opening Trend Settings from a Local Host ..................................................................... 3-21
Opening Trend Settings indstop from a Network Host .................................................... 3-22

3.8 Converting Data Formats ............................................................................................ 3-23

3.9 Printing Data ................................................................................................................ 3-27
Printing ............................................................................................................................ 3-27
Viewing a Print Preview .................................................................................................. 3-27

Chapter 4  Troubleshooting

4.1 Error Messages and Corrective Actions ...................................................................... 4-1
Search Folder Registration .............................................................................................. 4-1
Executing Searches .......................................................................................................... 4-1
Saving and Loading Settings and Search Results ............................................................ 4-2

Index
1.1 Overview of DataBrowser

Functional Overview
DataBrowser is a software application providing data file searching and display functions. It allows you to search for and display data files saved by Yokogawa recorders and data acquisition software programs from a local or network host.

Note
Hosts on the network must be running DataBrowser.

Data Search Function (Search Window)
Five categories of search conditions are available, making entry of criteria simple. Also, you can select multiple search conditions to refine your searches.

1. Time
You can search for files of a specific year, month, date, and time (Time Range), or for those of a specific time range regardless of the day (Time Range each day).

2. File Name
Search for data files of a specified file name or extension.

3. Data Type
Search for data files from a specific instrument (DX100/200, CX1000/2000, MX100, MV100/200, or FX100) or data acquisition software application (DAQLOGGER, AddTrigger, or AddMulti, MXLOGGER, MX Standard).

4. Keywords
Search for data files containing a specified keyword(s).

5. Serial Number
Search for data files of the specified instrument serial number.

Data Display Function (Trend Display Window)
- You can display waveforms of data having different times and acquisition intervals, and obtained by different instruments and applications, all on the same screen.
- You can read values using cursors, and compute statistics over an area.
- Data can be converted to Excel, text, or Lotus format.
- All data, or a range of data specified by the cursor can be printed.

Diagram of Data Saving and Loading
Communication with Network Hosts

DataBrowser can communicate with hosts on the network (other PCs running DataBrowsers) and execute searches, obtain data, download specified files, and acquire search results. The following is a description of the communication that occurs when executing functions on a DataBrowser network host from another DataBrowser.

For each request, (1) a connection with the host is made, (2) the request is sent and the response is received, (3) then the connection is closed. The connection with the host is not always open. Rather, it only opens when the request is issued.
1.2 System Requirements

Operating System (OS)
Run DAQWORX under any of the following operating systems.
- Windows Vista Home Premium SP2 (excluding the 64-bit editions)
- Windows Vista Business SP2 (excluding the 64-bit editions)
- Windows 7 Home Premium, SP1 (32-bit and 64-bit editions)
- Windows 7 Professional, SP1 (32-bit and 64-bit editions)
- Windows 8 (32-bit and 64-bit) (Supports the desktop mode)
- Windows 8 Pro (32-bit and 64-bit) (Supports the desktop mode)
The language displayed by the software under different language versions of the OS are as follows.

<table>
<thead>
<tr>
<th>OS Language</th>
<th>Software Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>Japanese</td>
<td>Japanese</td>
</tr>
<tr>
<td>Other</td>
<td>English</td>
</tr>
</tbody>
</table>

Note
- This manual uses screens displayed on Windows 2000 to describe the procedures.

PC
A PC that runs one of the OS above, and that meets the following CPU and memory requirements.

When Using Windows Vista
Pentium 4, 3 GHz or faster Intel x64 or x86 processor; 2 GB or more of memory

When Using Windows 7 or Windows 8
32-bit edition: Intel Pentium 4, 3 GHz or faster x64 or x86 processor; 2 GB or more of memory
64-bit edition: Intel x64 processor that is equivalent to Intel Pentium 4, 3 GHz or faster; 2 GB or more of memory

Note
- The specifications above are for a desktop PC, not a notebook PC.

Hard Disk
Free disk space: 200 MB or more

CD-ROM Drive (for Use during Installation)

Monitor
A video card that is recommended for the OS and a display that is supported by the OS, has a resolution of 1024×768 or higher, and that can show 65,536 colors (16-bit, high color) or more.

Printer and Mouse
A printer and mouse supported by the OS.

Ethernet Port
An Ethernet compatible port (10BASE-T or 100BASE-TX).
1.3 Starting and Exiting the Software

Starting the Software

Procedure

1. From the Windows Start menu, choose Programs > YOKOGAWA DAQWORX > DataBrowser > DataBrowser.

DataBrowser starts.

Note

When you start DataBrowser, it is restored to the same configuration that was active during the previous session. However, the search results in memory when exiting the software cannot be recovered in subsequent sessions.

Exiting the Software

Procedure

1. Choose File > Exit from the menu bar, or click the X button at the right end of the title bar.

DataBrowser closes.
1.4 Flow of Operations

The figure below shows the general flow of operation when using DataBrowser.

See section 1.3

Start DataBrowser.

See section 2.2

Register and specify search folders

See section 2.3

Specify search conditions

See section 2.4

Execute searches

See section 2.5

Display search results

See section 2.6

Add channels from search results to the trend display

See section 2.7

Save and load search conditions and result

See section 2.8

Dopy data files

See section 2.9

Searches within search results

See section 2.10

Specify search conditions

See section 2.11

Narrow the search results

See section 3.2

Select group for adding channels

See section 3.3

Channel display configure screen settings

See section 3.4

Trend display screen

Display cursor values
See section 3.5

Display computed results
See section 3.6

Save and load trend setting
See section 3.7

Convert data formats
See section 3.8

Print the data
See section 3.9
# Chapter 2  Operation of the Data Search Window

## 2.1 Names of Parts in the Data Search Window

### Menu bar

1. Open...
2. New Search configuration
3. New Trend configuration
4. Save Search settings...
5. Open Search results...
6. Save Search results...
7. Import Data files...
8. Search display
9. Trend display
10. About...

### Toolbar

1. Loads search settings from local or network hosts and displays them.
2. Opens a new Search window.
3. Opens a new Trend display window.
4. Saves search folder and search condition settings to the local host.
5. Loads search results from local or network hosts and displays them.
6. Saves search results to the local host.
7. Copies data files from a specified folder to another folder.
8. Displays the Search window.
9. Displays the Trend Display window.
10. Displays version information.
2.2 Registering and Specifying Search Folders

You can register source folders for data file searches. Up to two hundred folders can be registered, and up to eight of those can be specified at a time for a search.

Registering New Search Folders
The following is the procedure for registering new source folders for searches on local or network hosts.

**Procedure**

1. Open the Search window, then click the Add button in the Search paths area. The Search Path Configuration dialog box is displayed.

2. Select a folder to register, then enter a folder ID.

3. Click the Add button. The host name and ID of the registered folder appears in the Search paths area (the folder’s check box is selected, indicating that it will be included in any searches performed).

**Explanation**

Search Paths Area

- **Host Name**
  The name of the host of the registered folder.

- **Folder ID**
  The name specified for the folder when it was registered.
2.2 Registering and Specifying Search Folders

Add button
The Search Path Configuration dialog box is displayed when this button is clicked.

Remove button
Deletes the selected folder registration from the Search paths area.

Search source check boxes
Select or clear the check boxes to include or exclude folders from searches.

Search Path Configuration Dialog Box
Update button
Updates the directory tree for the local host.

Folder ID Box
You can enter an identifying string for the folder using up to sixteen alphanumeric characters. The folder ID is registered along with the folder.

Add button
Registers the selected folder using the specified folder ID.

Close button
Closes the Search Path Configuration dialog box.

Note
• Two or more folders cannot be registered under the same folder ID.
• Registered folders are shown under Folder List in the Registration from list tab of the Search Path Configuration dialog box. Up to two hundred folders can be registered. If you need to register a new folder when two hundred have already been registered, first delete one or more of the registered folders from the folder list.

Specifying a Folder from the List
The following is the procedure for selecting a search folder from the list of registered folders from local or network hosts.

Procedure

1. Open the Search window, then click the Add button in the Search paths area. The Search Path Configuration dialog box is displayed.

2. Click the Registration from list tab. The Registration from list tab is displayed.

3. Select a host from the Host List. The folders registered under the selected host appear in the Folder List.
2.2 Registering and Specifying Search Folders

4. Select a folder and click **Add**, or double-click the folder number. The host name and ID of the specified folder appear in the Search paths area (with check box selected).

![Host List](image)

**Explanation**

**Host List**

The Host List displays any hosts on the network that are running DataBrowser. Up to two hundred hosts can be displayed.

**Folder List**

The Folder List displays the folder ID and paths registered to the host selected in the host list. Up to two hundred folders can be displayed.

**Update button (red circular icon)**

Updates the host list and folder list.

**Update button (green arrow icon)**

Updates the folder list for individual hosts.

**Remove button**

Deletes folders from the folder list. (You can only delete folders registered to the local host.)

**Add button**

Adds the folder specified in the folder list to the Search paths list in the Search window.

**Registering a Folder from the Explorer**

**Procedure**

1. Open the Search window. Drag a folder you wish to register from the Windows explorer (from a folder) onto the Search window. The Reg. of search paths dialog box is displayed.

![Search window](image)
2.2 Registering and Specifying Search Folders

2. Enter a folder ID and click the **Add** button. The host name and ID of the registered folder appears in the Search paths area (the folder’s check box is selected, indicating that it will be included in any searches performed).

**Explanation**

**Path**
The Path column shows the absolute path to the folder that was dragged.

**Note**

- Two or more folders cannot be registered under the same folder ID.
- Registered folders are shown under Folder List in the Registration from list tab of the Search Path Configuration dialog box. Up to two hundred folders can be registered. If you need to register a new folder when two hundred have already been registered, first delete one or more of the registered folders from the folder list.

**Notes When Registering Search Folders**

**Note**

- Even if you delete a folder from the Search paths area, the folder is not removed from the Folder List. Likewise, even if you delete a folder from the Folder List, it is not removed from the Search paths area.
- A new folder cannot be registered under the same folder ID as one that is currently registered in the Search paths area.
- Likewise, a new folder cannot be registered under the same folder ID as one that is currently registered in the Folder List area. However, the same folder can be registered twice under a different folder ID.
2.3 Specifying Search Conditions

The following five categories of search criteria can be used. Multiple search conditions can be specified.
- Date and/or time range
- File name or extension
- Data type
- Keywords
- Serial numbers

Specifying a Date and/or Time Range

Procedure

1. Specify a search folder. (See section 2.2)
2. Select the Time check box in the Search conditions area.
3. Click the Time tab or click the word “Time” to the right of the check box. The Time tab is displayed.
4. Select Time Range (for a specific day) or Time Range each day (for any day).
5. Enter a range of dates and time (by year, month, date, and time), or a daily time range.

Explanation

Date and time specification allows you to search for files containing data acquired on certain dates and times.
- Milliseconds cannot be specified here, and any milliseconds in files are read as “0” by the program.
- The files included by the date and time specification range are shown in the figure below.

Given date/times A and B, the search finds any files containing data between A and B. As long as the file contains data between A and B, it is found even if it also contains data prior to A. Likewise, it is found if the start date/time is between A and B. Files (1), (2), and (3) are found, but not file (4).

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
</tr>
<tr>
<td>13:00:00</td>
<td>15:00:00</td>
</tr>
<tr>
<td>9:00:00 to 13:00:50</td>
<td>14:30:00 to 17:00:00</td>
</tr>
<tr>
<td>13:10:00 to 14:45:00</td>
<td></td>
</tr>
<tr>
<td>9:00:00 to 17:00:00</td>
<td></td>
</tr>
<tr>
<td>9:00:00 to 12:45:00</td>
<td>15:00:30</td>
</tr>
</tbody>
</table>
2.3 Specifying Search Conditions

Specifying a File Name or Extension

Procedure

1. Specify a search folder. (See section 2.2)

2. Select the File Name check box in the Search conditions area.

3. Click the File Name tab or click the words “File Name” to the right of the check box. The File Name tab is displayed.

4. Select the File Name or Extension option.

5. Enter the file name or extension to use as a search criterion.

Explanation

File name specification allows you to search for files whose names contain the specified keyword or extension.

File Name
You can enter an entire file name or portion thereof.

Extension
You can enter an entire file name extension or portion thereof.

Note
To specify multiple files names or extensions, use a space as a delimiter. Note that wildcards (*, ?, etc.) are not allowed.
2.3 Specifying Search Conditions

Specifying Data Types

**Procedure**

1. Specify a search folder. (See section 2.2)
2. Select the Data Type check box in the Search conditions area.
3. Click the Data Type tab or click the word “Data Type” to the right of the check box. The Data Type tab is displayed.
4. Select the types of data to search for.

**Explanation**

Data type specification allows you to search for files of the specified instrument or PC software.

**Data Types**

DAQLOGGER, AddMulti, AddTrigger, MX100 (data file created on the MX100 or with the MXLOGGER software or the MX100 standard software), DX100/DX200, MV100/MV200, and CX1000/CX2000, FX100

Specifying Keywords

**Procedure**

1. Specify a search folder. (See section 2.2)
2. Select the Keyword check box in the Search conditions area.
3. Click the Keywords tab or click the word “Keywords” to the right of the check box. The Keywords tab is displayed.
4. Select a search key, then enter a keyword or keywords to search for.
2.3 Specifying Search Conditions

**Explaination**
Keyword specification allows you to search for files that contain the keywords in their text or data. Files that do not contain any data of the specified search key are not included in the search. The table below shows the types of data available by product.

<table>
<thead>
<tr>
<th>File comments</th>
<th>AddMulti</th>
<th>AddTrigger</th>
<th>MX100</th>
<th>DX100/200</th>
<th>MV100/200</th>
<th>CX1000/2000</th>
<th>FX100</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch information</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Tag comments</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Tag numbers</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Channels</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Group names</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Marks/Messages</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

✓: data type exists in data file, Blank: data type not included

**Note**
- You can specify multiple keywords by separating them with a space.
- If multiple search keys are selected, the software searches for files whose keywords are found in data corresponding to all of the keys.
- Up to one thousand marks/messages can be found per file. All other marks or messages thereafter are not found.

**Specifying a Serial Number**

**Procedure**

1. Specify a search folder. (See section 2.2)
2. Select the Serial No. check box in the Search conditions area.
3. Click the Serial No. tab or click the words “Serial No.” to the right of the check box. The Serial No. tab is displayed.
4. Enter a serial number.

**Explanation**
Serial number specification allows you to search for data files of the specified instrument serial number.

**Note**
- DAQLOGGER, AddMulti, and AddTrigger do not have serial numbers, and therefore data acquired by those programs cannot be searched for using this criterion.
- Enter the serial number carefully as only exact matches will be found.
2.3 Specifying Search Conditions

Specifying Search Conditions

Specifying Multiple Search Conditions
You can apply multiple or even all entered search conditions to the same search, including date and/or time, file name, data type, keyword, and serial number. As in the figure below, the major search categories are combined in an AND relationship, and the conditions within each category are applied in an OR relationship.

When specifying search items, for example date/time and data type, files with data from the specified date/time and of the specified data type are found.

When specifying search conditions within a tab, for example two or more data types, files of any of the specified type are found.

Searching Subfolders
If you select Search subfolders, any subfolders existing in the registered search paths are included in the search. If Search subfolders is not selected, any subfolders within the primary search folders are not included.

If Search Subfolders is Cleared
• Searches only the files within the specified folder
• Data files (1) to (9) are not searched

If Search Subfolders is Selected
• Searches the subfiles within the specified folder
• All data files (1) to (9) are searched

Note
The maximum allowable length for a path is 255 characters including the file name.
## 2.4 Executing the Search

### Procedure

1. Specify search folders and search conditions. (See sections 2.2 and 2.3)
2. Click the **Search** button in the Search conditions area. (Select the Search subfolders check box if necessary.)

   ![Search status dialog box](image)

   The Search status dialog box appears.

### Explanation

**Host Name**
Displays the name of the host containing the specified search folder.

**Folder ID**
Displays the folder ID of the specified search folder.

**Status (left)**
Displays the search status.
- Starting → Searching → Receiving data in progress ...% → Finished
- Error: An error occurred during the search.
- Stop: Press to stop the search.

**Status (right)**
Displays the results of the search. The number to the left of the slash indicates the number of files that matched the criteria, and the number to the right represents the total number of files searched. The number of files that can be searched from a single registered folder ID is sixty thousand. Once that limit is reached, the search stops.

**Error button**
If an error occurs, the button becomes " [ ] " You can click the Error button to display the contents of the error message.

**Error**
Displays the error number and message.

**Total**
Displays the total number of files found and searched.

**Stop button**
 Stops the search. Once a search is stopped, the results obtained in progress are displayed.

**Close button**
Closes the Search status dialog box. When the search stops, the Stop button changes to the Close button.
2.5 Displaying Search Results

Displaying the Search Status

Procedure

1. When a registered folder is searched with specified conditions, the search results are displayed in the Search results area.

Registering Search Folders (section 2.2), Specifying Search Conditions (section 2.3), Executing the Search (section 2.4)

Click a file in the search results area to display its details

Explanation

Search Results Area
Displays any found files in a list. The list is located in the lower left part of the screen.

- **File Name:** The names of the found files.
- **Data Type:** The data type of the found files.
- **Start Time:** The time of the first data in the found files.
- **End Time:** The time of the last data in the found files.
- **Title:** Any titles given to the found files.
- **Comment:** Any comments included with the files.
- **Host Name[Folder ID]:** The host name and folder ID of the found files.

Note
- Data files are listed in the order in which their hosts were registered.
- If multiple titles and comments exist, only the first title or comment is displayed.
2.5 Displaying Search Results

Specifying Pages
One hundred search results are displayed on a single page. If several pages are generated, you can access other pages by clicking the arrow buttons in the upper right of the Search results area.

Open button
Opens previously saved search results files. (See section 2.6)

Save button
Saves the currently displayed search results. (See section 2.6)

Sort Function
You can sort the search results by various items. When you click a column title in the search results display, the Sort Status dialog box appears, and the results are sorted according to the information in that column.

If you click the Stop button during the sort, the items are restored to their original order.

Resize button
• Clicking this button widens the search results area to its maximum width. Click the Resize button again to restore the window to its original size.
• You can also drag the button to the right to size the window manually. (Unless the area is already at its maximum width)

Narrowing the Search Results

Procedure

1. Specify search conditions.
2. Click the Search within results button in the Search conditions area.

Explanation
The Search within results button allows you to perform a search of the files found during the previous search. This function allows you to do the following.
• When a large number of search results are obtained, you can find desired files by applying new conditions and searching through those results.
• If you save the search results (see section 2.6), you can perform multiple, different searches on those results. By combining the Save/Open functions with the Search within results function, you can create a search results file that fits your particular task.

Note
The Search within results function searches on-screen files, and does not perform communication. Searching within results can be performed on the local data, but data from files found on a network host cannot be displayed (see chapter 3). To display data, the network hosts must be running DataBrowser.
2.5 Displaying Search Results

Displaying File Details

**Procedure**

1. Click a file in the search results area to display its details in the File Details area.

   Click the tag display switching buttons to display the channel, Tag No., or Tag comment.

   **Explanation**

   **Host Name [Folder ID]**
   Displays the host name and folder ID.

   **Channels**
   Displays the number of channels in the current file.

   **File Name**
   Displays the path and file name of the current file.

   **No.**
   A number for the files in the list.

   **Add**
   A button for adding the item to the trend display. (See section 2.7)

   **Tag display switching buttons**
   Channel: Displays the channel numbers.
   Tag No.: Displays the tag numbers.
   Tag Comment: Displays the tag comments.

   **Interval [sec]**
   Displays the save interval for each channel.

   **Size [samples]**
   Displays the number of data for each channel.

   **Serial No.**
   Displays the serial number for each channel.

   **Start Time**
   Displays the time of the first data for each channel.

   **End Time**
   Displays the time of the last data for each channel.

   **Trigger Time**
   Displays the trigger time for each channel.
2.5 Displaying Search Results

**Note**  
Tag numbers and serial numbers are not displayed for the following data types.  
Tag numbers  CX1000/2000, DX100/200, MV100/200, FX100  
Serial numbers  DAQLOGGER, AddMulti, AddTrigger, MX100  
Serial numbers are also not displayed for computation-only data from the MX100, and for data saved by Viewer.

"Show the file information display" button  
Click this button to display the Datafile Information dialog box for the found file.

Comment  
Displays the comments (title and comment) for the selected data file. If no data exists, nothing is displayed.

Mark/Message  
Displays the number and text of marks for the selected data file. If no data exists, nothing is displayed.

Batch Information  
Displays the batch information (Application, Supervisor, Manager, Batch Name, Comment User, Comment) for the selected data file. If no data exists, nothing is displayed.

Group Name  
Displays the number and names of groups for the selected data file. If no data exists, nothing is displayed.
2.6 Adding Channels from Search Results to the Trend Display Window

The following describes the procedure for adding channels from the search results to the Trend display window.

Collectively Adding a Selected Range of Channels

**Procedure**

1. Select a file from the search results area to display its details. (See section 2.5)
2. Select a range of channels to add and click the **Add channels to this trend configuration** button.

Adding Individual Channels

**Procedure**

1. Select a file from the search results area to display its details. (See section 2.5)
2. Click the **Add** button next to the channel to add, or double-click its number.

**Note**

The Add buttons are hidden if the File Details area is scrolled to the right. In this case, you can double-click the item or click the Add channels to this trend configuration button.
2.7 Saving and Loading Search Settings and Results

Saving Search Settings

Procedure

1. Click \(\text{ }\) on the toolbar or choose File> Save search settings as from the menu bar. The Save search settings dialog box appears.

2. Enter a file name and comment and click the Save button. The currently specified search folder and search conditions are saved.

Explanation

File List
Displays the search settings file name and comments of the search settings saved on the local host.

Delete button
Deletes the selected search settings file.

Update button
Updates the displayed search results file list.

File Name
Enter the name of the file you wish to save. (An extension is automatically added.)

Comment
Enter comments to be saved with the file. Up to 255 alphanumeric characters can be entered.

Save button
Saves the settings file under the specified file name on the local host.

Note
After saving a search settings file, the saved file name and comment appears in the text box the next time you open the Save search settings dialog box (these items are blank if no settings have been saved previously, or when starting up the software). Also, when you select a file in the Save search settings dialog box, the file and comment are displayed in the input boxes at the bottom of the window. This allows you to conveniently overwrite settings.
2.7 Saving and Loading Search Settings and Results

Opening Search Settings from a Local Host

**Procedure**

1. Click on the toolbar or choose **File > Open** from the menu bar. The Open dialog box is displayed.

   ![Open dialog box](image)

   - **Delete button**: Deletes the selected file.
   - **Update button**: Updates the displayed file list.
   - **Drag to change the column width**: Allows you to adjust the width of the columns.
   - **Double-click a number to open the file**: Opens the selected file number.

2. Select a file and click **Open**, or double-click the file number. The Information dialog box opens.

   ![Information dialog box](image)

3. Click the **Yes** button. The search paths and search conditions loaded from the search settings file are displayed. Click **No** to close the Information dialog box.

**Explanation**

- **File List**
  Displays the name of the settings file and comments saved on the local host.
- **Delete button**
  Deletes the selected file.
- **Update button**
  Updates the displayed file list.
- **File Type**
  - If you select all files (.dbc, .dbv), the saved search settings files and display settings files are displayed.
  - If you select Search settings file (.dbc), only the search settings files are displayed.
  - If you select Trend settings file (.dbv), only the display settings files are displayed.
- **Open button**
  Opens the settings file selected in the File List. When a search settings file is opened, the Search window becomes active. (When a trend settings file is opened, the Trend display window becomes active.)
- **Cancel button**
  Closes the Open dialog box.
Opening Search Settings from a Network Host

1. Click  on the toolbar or choose File> Open from the menu bar. The Open dialog box is displayed.

2. Click the Hosts on network tab. The Hosts on network tab is displayed.

3. Click the Update button. The names of hosts running DataBrowser, and their corresponding files names and comments are displayed.

4. Select a host from the Host List. The a list of files saved on the selected host is displayed.

5. Select a file from the list that you wish to load and click Open, or double-click the file number. The Information dialog box opens.

6. Click the Yes button. The search paths and search conditions loaded from the search settings file are displayed. Click No to close the Information dialog box.

**Explanation**

**Host List**
The Host List displays the names of any hosts on the network that are running DataBrowser. Up to two hundred hosts can be displayed.

**File List**
Displays the settings files and comments saved on the host selected in the host list.

**Host Name**
Displays the name of the host selected in the host list.

**Update button**
Updates the host list and file list.

**File Type, Open Button, and Cancel Button**
See Opening Search Settings from a Local Host.
2.7 Saving and Loading Search Settings and Results

Saving Search Results

**Procedure**

1. Click the **Save** button in Search results area or choose **File> Save** the search results as from the menu bar. The Save dialog box appears.

   - **Delete button**: Deletes the selected search results file.
   - **Update button**: Updates the displayed search results file.
   - **Drag to change the column width**: Allows you to adjust the width of the columns.

2. Enter a file name and comment and click the **Save** button.
   The displayed search results are saved.

**Explanation**

**File List**
Displays the name of the search results file and comments saved on the local host.

**Delete button**
Deletes the selected search results file.

**Update button**
Updates the displayed search results file.

**File Name**
Enter the name of the file you wish to save. (An extension is automatically added.)

**Comment**
Enter comments to be saved with the file. Up to 255 alphanumeric characters can be entered.

**Save button**
Saves the search results file under the specified file name on the local host.
Opening Search Results from a Local Host

**Procedure**

1. Click the Open button in Search results area or choose File > Open the search results from the menu bar. The Open dialog box is displayed.

   ![Open dialog box](image)

   - Delete button
   - Update button
   - Drag to change the column width
   - Double-click a number to open the file

2. Select a file and click Open, or double-click the file number. The Information dialog box opens.

   ![Information dialog box](image)

3. Click the Yes button. The search results loaded from the search results file are displayed. Click No to close the Information dialog box.

**Explanation**

- **File List**
  Displays the name of the search results file and comments saved on the local host.

- **Delete button**
  Deletes the selected file.

- **Update button**
  Updates the displayed file list.

- **Open button**
  Opens the search results file selected in the File List.

- **Cancel button**
  Closes the Open dialog box.
2.7 Saving and Loading Search Settings and Results

Opening Search Results from a Network Host

**Procedure**

1. Click the **Open** button in Search results area or choose **File > Open** the search results from the menu bar. The Open dialog box is displayed.

2. Click the **Hosts on network** tab. The Hosts on network tab is displayed.

3. Click the Update button. The names of hosts running DataBrowser, and their corresponding files names and comments are displayed.

4. Select a host from the Host List. The a list of files saved on the selected host is displayed.

5. Select a file from the list that you wish to load and click **Open**, or double-click the file number. The Information dialog box opens.

6. Click the **Yes** button. The search results loaded from the search results file are displayed. Click **No** to close the Information dialog box.

**Explanation**

**Host List**
The Host List displays the names of any hosts on the network that are running DataBrowser. Up to two hundred hosts can be displayed.

**File List**
Displays the settings files and comments saved on the host selected in the host list.

**Host Name**
Displays the name of the host selected in the host list.

**Update button**
Updates the host list and file list.

**Open Button and Cancel Button**
See Opening Search Results Files from a Local Host.
2.8 Copying Data Files

This section describes the procedure for copying a data file from a specified folder to another folder.

Procedure

1. Click on the toolbar or choose File > Import Data Files from the menu bar. The Import Data files dialog box opens.

2. Click the Select button for the Source. The Browse for Folders dialog box is displayed.

3. Select a source folder and click the OK button. The Import Data files dialog box reappears.

4. As in step 2, click the Select button for the Destination. The Browse for Folders dialog box is displayed.

If you do not want to create a new folder, skip to step 7.
5. Select a location in which to create a new folder, and click the **New Folder** button. The Create New Folder dialog box is displayed.

![Create New Folder dialog box]

6. Enter the name of the folder to be created, and click the **OK** button. The Browse Folders dialog box is displayed (the screen in step 4).

7. Select the destination folder and click the **OK** button. The Import Data files dialog box reappears.

![Import Data files dialog box]

8. Click the **Start** button. When copying is complete, “Completed” is displayed in the bottom of the Import Data files dialog box along with the number of copied files.

![Import Data files dialog box with completed message]

**Explanation**

The Import Data files function allows you to copy data files saved on the floppy disk or CF card of a recorder to a specified folder. By specifying a copy source and destination the first time you import files, subsequent imports can be done quickly and easily.

**Note**

Only folders on the local host can be specified as the source and destination folders.

**Select Buttons (Import Data files Dialog Box)**

- A folder for specifying folders is displayed.

**New Folder (Browse Folders Dialog Box)**

- Lets you create a new folder in a specified location. The Create New Folder dialog box is displayed.

**Start Button (Import Data files Dialog Box)**

- Executes the import of data files. This button is not active unless a source and destination folder are selected.

**Stop Button (Import Data files Dialog Box)**

- Becomes available once importing has started. Stops the importing of data files.

**Close Button (Import Data files Dialog Box)**

- Closes the Import Data files dialog box.

**OK Button (Create New Folder Dialog Box)**

- Creates the new folder.

**Cancel Button (Create New Folder Dialog Box)**

- Cancels creation of the new folder and closes the Browse Folders dialog box.
Chapter 3  Operation of the Trend Display Window

3.1 Names of Parts in the Trend Display Window

The Trend display window consists of the display channel settings screen and the waveform display screen.

Opening the Trend Display Window

Procedure

1. Click on the toolbar or choose View> Trend display from the menu bar. The Trend display window opens.

Display Channel Setting Screen

The display channel setting screen can display the channel information screen, or the channel display configure screen, each of which contain channels added from the search results.

Channel Information Screen

<table>
<thead>
<tr>
<th>Group Name</th>
<th>Group ID</th>
<th>Channel</th>
<th>Start Time</th>
<th>End Time</th>
<th>Zone</th>
<th>Trip 1</th>
<th>Trip 2</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y01</td>
<td></td>
<td></td>
<td>2000/01/03</td>
<td>2000/01/03</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Y02</td>
<td></td>
<td></td>
<td>2000/01/03</td>
<td>2000/01/03</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Y03</td>
<td></td>
<td></td>
<td>2000/01/03</td>
<td>2000/01/03</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Y04</td>
<td></td>
<td></td>
<td>2000/01/03</td>
<td>2000/01/03</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Y05</td>
<td></td>
<td></td>
<td>2000/01/03</td>
<td>2000/01/03</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Y06</td>
<td></td>
<td></td>
<td>2000/01/03</td>
<td>2000/01/03</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Y07</td>
<td></td>
<td></td>
<td>2000/01/03</td>
<td>2000/01/03</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Y08</td>
<td></td>
<td></td>
<td>2000/01/03</td>
<td>2000/01/03</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Channel Display Configure Screen
Group Name
You can specify a group name using up to thirty alphanumeric characters.

No.
Number assigned within groups.

Channel, Tag Number, and Tag Comment
Displays identifiers for the channels (display can be switched using the group tab toolbar).

Start Time
Time of the first data.

End Time
Time of the last data.

Trigger Time
Time of the trigger point (if no trigger point exists, the first data is used.)

Interval [sec]
The save interval for the data.

Data Size
The number of saved data.

Data Type
The instrument or software that saved the data.

File Name
Name of the file to which the channel belongs.

Host Name
Name of the host on which the channel to which the file belongs resides.

Toolbar

Display Channel Setting Screen Toolbar (for Channel Info and Configure Screens)

Display Channel Setting Screen Group Tab Toolbar
3.1 Names of Parts in the Trend Display Window

Editing Functions in the Channel Display Configure Screen

Drag to select a range

Copy
Copies the selected range to the clipboard.

Paste
Pastes copied contents to the displayed group. If a range is selected, pastes the contents into that range. If a range is not selected, the contents are added at the bottom.
3.1 Names of Parts in the Trend Display Window

Waveform Display Screen
Displays the waveforms of the channels in the channel information screen.

Menu bar
Toolbar
Waveform Display Screen Toolbar

Waveform Display Screen Toolbar
- Linked group settings (OFF, 1, 2, 3, 4)
- Switches the time reference mode (Start, Trigger, End, Time)
- Select all
- Delete cursors
- Shows/hides alarms
- Copy
- Reacquires channel data
- Opens the trend display screens
- Opens the channel setup screens
- Shows channel details
- Displays conversion settings
- Displays computed results (statistics)
- Clip
- Scale calculation
- Switches the trend display (User zone, Edit zone, Full zone, Side zone, Auto zone, Multi-zone)
- Switches between Channel, Tag No., and Tag Comment
- Zoom in and out, display all, specify factor
- Switches between absolute time/Relative time
3.2 Selecting a Group for Adding Channels

Channels can be assigned to groups in the channel display configure screen. Up to fifty groups can be created, each with up to thirty-two channels. When channels are added in the Search window (see section 2.6) they are added to the selected groups.

Adding and Deleting Groups

Clicking the button in either of the channel setup screens adds a new group tab on the end of any existing tabs.

Clicking the button in either of the channel setup screens deletes the currently displayed group tab.

Linked Group Settings

This function links cursor positions and time reference modes across groups in the trend display screen. The available settings are Link OFF, Link 1, Link 2, 3, and 4. You can select either from any group. Groups with the same link number are called linked groups, and up to four linked groups can be set.

Select a group, then select one of the options

<table>
<thead>
<tr>
<th>Channel</th>
<th>Y-Axis</th>
<th>No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>CH1</td>
<td>Linear</td>
<td>01</td>
</tr>
<tr>
<td>CH2</td>
<td>Linear</td>
<td>02</td>
</tr>
<tr>
<td>CH3</td>
<td>Linear</td>
<td>03</td>
</tr>
<tr>
<td>CH4</td>
<td>Linear</td>
<td>04</td>
</tr>
</tbody>
</table>
3.3 Settings in the Channel Setup Screens

**Procedure**

You can edit display settings by following the indications in the figure below.

- **Display channel details.**
- **Switch the displayed group.**
- **Select channels.**
- **Switch between the channel Information and channel display configure screens.**
- **Set linked groups (OFF, 1, 2, 3, 4).**
- **Add/delete/move forward/backward groups.**

**Explanation**

**Display/Hide Channels**

By selecting and clearing the check buttons in the No. column on the channel display configure screen, you can select whether to display those channels’ data in the Trend display screen.

**Channel (Tag Number and Tag Comment): Can be selected/deselected for display.**

The Channel column displays the channel, tag number, and tag comment.

**Display/Hide Y-Axis and Type**

By selecting and clearing the check buttons in the Y-axis column, you can select whether to display the Y-axes of the corresponding channels in the Trend display screen. This setting is only valid if multiple zones are specified in the Trend display screen.
Minimum and Maximum Values of Scale, and the indstart Scale Value
Display Format instop
You can set the maximum and minimum values of the scale when displaying waveforms. The value in the Scale Min column is the lower end of the Y-axis, and that of the Scale Max column is the upper end.
In the Form. column, you can specify floating point or exponential format for the scale values.

<table>
<thead>
<tr>
<th>Form</th>
<th>Scale</th>
<th>Waveform Display Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Setting the Waveform Display Zones
You can set waveform display range for displaying trends. The waveform display range is set as 0% at the bottom, and 100% at the top. The values in the Zone Min and Max columns represent the lower (0-9%) and upper (1-100%) ends of the trend display range.

Setting Trip Points
You can display a trip line to indicate a particular value of interest (trip point) in the trend display area. Two trip points (trip 1 is red, trip 2 is blue) can be set for each waveform. By selecting and clearing the check buttons in the Trip 1 and Trip 2 columns, you can select whether to display the corresponding trip points in the Trend display screen.

Trip line ON/OFF

Waveform Display Screen
3.3 Settings in the Channel Setup Screens

Channel Display Colors
You can assign colors to channels displayed in the trend display screen. Click the colored part to open the Color Settings dialog box.

Showing Channel Details
You can view detailed information about a channel selected in the channel setup screens.

- Click the [ ] icon in the channel setup screen toolbar. The Channel Information dialog box opens.

Information Tab
Displays the start time, end time, trigger time*, interval (sec), data size, data type, file name, path name, and host name.
* (If the data has no trigger point, the first data is used.)

Comment Information Tab
Displays the title and tag comment. Displays all comments. The item is blank if the data contains no comments.

Batch Information Tab
Displays the batch information. The items are blank if the data contains no batch information. The displayed items are application, supervisor, manager, batch name, lot number, comment user, comment time, and comments 1 through 3 (for details, see the user’s manual of the instrument that saved the batch information.)
3.4 Displaying Trends

Displays waveforms according to the settings in the channel setup screens.

**Procedure**

1. Click the **Show the trend display** button in either of the channel setup screens. The channels selected in the tab are loaded. While loading, the "Receiving" dialog box is displayed, and when complete, the waveforms appear (click the Cancel button to stop the loading process. Only the waveforms of channels completely loaded at the point the Cancel button was clicked are displayed. To load the remaining waveforms, click the "Get data for all channels" button).

**Note**

If some channels are not displayed, check the following.
- That the host exists, and that it is running DataBrowser.
- That the files shown under File Name in the folder indicated by the path in the Channel Information dialog box exist.
- That the network is connected correctly, and that no problems occurred on the network.
3.4 Displaying Trends

**Explanation**

**Group Selection Tabs**
Click a tab to display the group. The name displayed is the one specified in the channel setup screen.

**Waveform Display Area**
The area in which the waveforms are displayed. Displays waveforms according to the settings in the channel setup screens. Click in the waveform display area to display a cursor. Drag the cursor to display a second cursor. Cursor A appears at the position where you first clicked; Cursor B appears at the position where you released the mouse button. (See section 3.5, "Displaying Cursor Values."

**Alarm Display Area**
The area in which the alarms are displayed. Toggle the display using the Alarm ON/OFF button on the toolbar.

**Y-Axis Display Area**
The area in which the Y-axes are displayed. The Y-axes are shown in the specified colors. If the trend display is user zone, edit zone, full zone, or slide zone, only the Y-axis of the active channel is displayed. For auto zone or multi-zone, all channels are displayed.

**Time Axis Display Area**
The area in which the time axis is displayed. You can select the display range using the scroll bar. Toggle the display between absolute time and relative time display using the button on the toolbar.

**Zone Display Area**
The area in which the display status of each channel can be changed.

- **Active Y-Axis Mark**
  The channel with this mark is the active channel. The waveform and alarm data of the active channel are displayed in front.

- **Grid Color Adjustment Slider**
  Drag the slider up and down to adjust the grid color between white and black.

- **Background Adjustment Slider**
  Drag the slider up and down to adjust the background color between white and black.

- **Y-axis button**
  Each channel has its own color-coded button. Click a button to make its channel active. The active Y-axis mark moves to the top of the clicked button.

- **Zone Display Bar**
  Click to show or hide the zone display area.

- **Zone Size Bar**
  Drag to change the width of the zone display area.

- **Show/Hide Waveform Buttons**
  Click to show or hide channels. These buttons mirror the waveform display ON/OFF buttons in the channel display configuration screen.

**Trip Point Display Area**
Displays trip points.

**Mark Display Area**
Displays marks. All marks of the channels registered to the displayed groups are displayed. Up to one thousand marks per channel can be displayed, and they can be added, edited, or deleted here. When marks are displayed on top of one another, the mark of the active channel is displayed in front.
3.4 Displaying Trends

Time Axis Display Area
- The time display shows the time of the channel. When the time reference mode is Start Reference, Trigger Reference, or End Reference, the time of the active channel is displayed.
- The time display shows the time relative to the start of the waveform display area.

Showing Channel Details
In the Trend display screen, the information of the active channel is displayed.

Displaying Waveforms of Different Intervals
Data of differing measurement intervals can be displayed in the same waveform display screen.

Measurement Interval of Displayed Waveforms
When the measurement intervals differ, the greatest common factor of the measurement intervals of the channels assigned to the displayed groups is used as the minimum interval unit for displaying all of the waveforms. In the figure below, since the intervals for the three channels are 1 s, 500 ms, and 250 ms respectively, 250 ms is used as the interval when all channels are displayed together.

![Waveform Display Example](image)

Displaying Waveforms of Intervals Greater Than the Minimum Unit
If a channel's interval is longer than the minimum unit interval, data values that are not measured points are displayed at the value of the points directly thereafter.

![Waveform Display Example](image)

Minimum Unit Interval for Linked Groups
The greatest common factor of the measurement interval of all channels registered to all groups belonging to the linked group is used as the minimum unit interval.
3.4 Displaying Trends

Time Reference Mode

There are four time reference modes: Start Reference, Trigger Reference, End Reference, and Time Reference.

Start Reference
Waveforms are displayed using the first data of the channels assigned to the group as a reference.

Trigger Reference
Waveforms are displayed using the trigger point of the channels assigned to the group as a reference.

End Reference
Waveforms are displayed using the last data of the channels assigned to the group as a reference.

Time Reference
Waveforms are displayed using the measurement time of the channels assigned to the group as a reference.

Save Format of Displayed Data

Data files are saved in two formats: one for waveform display and one for the cursor value dialog box. Data saved in different formats can be displayed in the same Trend display screen.

The format in which one data is saved per unit of time is called Normal format, and the format in which two data—a minimum and maximum value—are saved per unit of time is called MinMax format.

The following shows the correspondence between data types and save formats.

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Normal Format</th>
<th>MinMax Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>DX100</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>MV100/MV200</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CX1000/CX2000</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>FX100</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>MX100</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>DAQLOGGER</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>AddMulti</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>AddTrigger</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

Note

Instruments that can save in MinMax format such as the DX100/200, MV100/200, CX1000/2000, and FX100 save data in two formats called Event data and Display data format. Event data is saved in Normal format, and Display data is saved in MinMax format. For details, see the user’s manual for your particular instrument.
3.4 Displaying Trends

Waveform Display in Normal Format indstop and indstart MinMax Format
In Normal format, waveforms are displayed in the position corresponding to the data value at that time.
In MinMax format, waveforms are displayed as a fill between the two points corresponding to the Min and Max values at that time. When the Min and Max values are the same, items are displayed as if in Normal format. If the difference between the Min and Max values is large, the thickness of the trace increases.

Intersection between Waveform and Cursor
In Normal format, the intersection is marked with a circle.
In MinMax format, the two intersecting points of the Min and Max values are enclosed by an ellipse.

Displaying Alarms
You can show or hide the alarm display area using the Alarm ON/OFF button on the toolbar. This operation mirrors the alarm ON/OFF operation in the Cursor Value dialog box. Up to four alarm levels per channel are allowed. As shown in the figure below, the alarm levels are 1, 2, 3, and 4, starting from the top level. The colors of channels on which alarms occurred indicate the period of occurrence. If multiple alarms occur at the same time, the alarm of the active channel is displayed in front.

Y-Axis Display
There are six formats for the Y-axis: user zone, edit zone, full zone, slide zone, auto zone and multi-zone. You can switch between them using the toolbar.
User Zone
The waveform of each channel is displayed in the position specified under Zone in the channel display configure screen. A single Y-axis of the active waveform is displayed.
3.4 Displaying Trends

Edit Zone
The waveform of each channel is displayed in the position specified under Zone in the Channel Display Configuration Screen. You can edit the waveform display range by manipulating the Y-axis buttons in the zone display area. Move the waveform position by dragging the Y-axis button up and down. The waveform zone settings implemented here are reflected in the Zone setting in the Channel display configuration screen, as well as the user zone and multi-zone settings. A single Y-axis of the active waveform is displayed.

Full Zone
Displays all the waveforms over the full zone of the waveform display area regardless of the Zone settings on the Channel display configuration screen. A single Y-axis of the active waveform is displayed.

Slide Zone
Displays the waveforms by slightly offsetting the display position of each waveform vertically regardless of the Zone settings in the Channel display configuration screen. A single Y-axis of the active waveform is displayed.
Auto Zone
Displays the waveforms by dividing the waveform display area evenly according to the number of displayed waveforms regardless of the Zone settings in the Channel display configuration screen.

Multi-Zone
Arranges all the Y-axes from left to right, displaying all specified Y-axes. Y-axes not selected in the Channel display configuration screen are not displayed. The display range is set using the Zone parameter in the Channel display configuration screen. When you drag a Y-axis button onto the Y-axis display area, the Y-axis of the relevant channel is displayed. Conversely, if you drag a Y-axis onto the zone display area, the Y-axis of the relevant channel is hidden.

Clip Function
Turning ON the clip function forces displayed points on the waveform that fall outside of the scale range to revert to the max. or min. value of scale. Use the Clip button on the toolbar to turn the clip function ON and OFF.
Trip Point

The trip points are displayed according to the Trip 1 and Trip 2 settings in the Channel display configuration screen. You can drag the trip 1 and trip 2 displays to change them. These changes are reflected in the Trip 1 and Trip 2 items in the Channel display configuration screen.

You can change the trip point by dragging

Copying the Trend Display

Clicking the XX button (copy button) in the Trend display toolbar copies the displayed trend screen. You can paste the copied screen onto a standard "Paint" program that comes with your operating system.
### 3.5 Displaying Cursor Values

#### Procedure

1. In the waveform display, click the group from which you wish to read values using cursors.

2. Click the position in the waveform display area where you wish to read the data. If you wish to read another point at the same time, drag the cursor. Cursor A appears at the position where you first clicked; Cursor B appears at the position where you released the mouse button. The measurement point is displayed where the waveform and the cursor cross using a yellow circle.

3. Click the Display Cursor Rearout button on the toolbar. The Cursor Readout dialog box opens.

#### Explanation

The data at the currently displayed cursors are displayed.

**Data No.**

Displays the data number at the Cursor A and B positions.

**Time Difference**

Displays the time difference between cursors A and B.

**Relative Time**

Displays the time using the first data of the displayed range between cursors A and B as a reference.

**Value A and Value B**

Displays the values and alarms of each channel at cursor A or cursor B. Changes to red if an alarm occurred, and green if an alarm did not occur. The value is blank if no data exists at the cursor position.

**Value B-A**

Displays the result of subtracting the values at cursor A from those at cursor B.

**Time A and Time B**

Displays the time at cursors A and B.
3.5 Displaying Cursor Values

**Normal and MinMax Format Display**
Values of channels in Normal format are displayed in a single row. Values of channels in MinMax format are displayed in two rows, one for the minimum and maximum value at the cursor position.

**Switching the Active Channel**
You can switch the active channel. The active channel mark is displayed between the waveform number and its color. Click the box of the channel you wish to make active. This changes the active channel in the trend display screen as well.

**Moving Cursors**
You can move the cursor positions on the trend display using the Up and Down buttons.

**Note**
- The cursors used to display cursor values and those used to specify the interval for statistical computation over an area are the same.
- The Cursor Readout dialog box and opens. The Computation Results dialog box can be displayed at the same time.
- If you click a different group in the Trend display screen with the Cursor Readout dialog box open, the Cursor Readout dialog box displays the cursor values of the selected group.
- You can change the cursor positions in the trend display screen while the Cursor Readout dialog box is open.

**Deleting Cursors**
Click the button (Erase Cursor button) on the Trend display toolbar. The cursors are cleared as well as the cursor values displayed in the Cursor Readout dialog box.
3.6 Displaying Computed Results (Statistics)

**Procedure**

1. In the waveform display screen, click the tab of the group on which you wish to perform statistical computation over an area.
2. Click the start point of the computation area in the waveform display area, then drag the cursor to define the area and end point (use the cursor in the same manner as in section 3.5, Displaying Cursor Values.)*
3. Click the Statistics button on the toolbar. The Statistics dialog box opens.

**Explanation**

Specify using two cursors the interval over which computation is to be performed. If the cursors are not displayed, all the data are used in the statistical computation. The statistical parameters are the minimum value, the maximum value, the P-P value (maximum - minimum), the mean value, and the rms value. The computation is executed when the dialog box is displayed, or when you click the Calculate button. (Channels in Normal format are displayed in a single row. Values of channels in MinMax format are displayed in two rows, one for the minimum and maximum value at the cursor position. )

- **Min and Max**
  Shows the maximum and minimum values of the range selected by the cursors, or the entire range.

- **PP**
  Shows the difference between the maximum and minimum values of the range selected by the cursors, or the entire range.

- **Mean**
  Shows the mean values of the range selected by the cursors, or the entire range.

- **RMS**
  Shows the RMS values of the range selected by the cursors, or the entire range.

- **Start Time and End Time**
  Shows the start and end times for computation for each channel.

- **Progress Bar**
  Displays the execution status of the computation.

- **Calculate button**
  Recalculates the statistics. If you change the positions of cursors while the Statistics dialog box is open, click this button to refresh the computed results.

**Note**

- The cursors used to display cursor values and those used to specify the interval for statistical computation over an area are the same.
- The Statistics dialog box and Cursor Value dialog box can be displayed at the same time.
- The statistical results are not linked to cursor movements or switching of groups. After any such changes are made, click the Statistics button or the Calculate button to recalculate and display the results.
3.7 Saving and Loading Trend Settings

Saving Data Trend Settings

Procedure

1. Click (the Save button) in the DataBrowser window or choose File > Save current trend configuration as from the menu bar. The Save the trend settings dialog box appears.

2. Enter a file name and comment and click the Save button. The currently displayed trend settings are saved.

Explanation

File List
Displays the trend settings file name and comments saved on the local host.

Delete the selected file button
Deletes the selected trend settings file.

Update button
Updates the trend settings file list.

File Name
Enter the name of the file you wish to save (an extension is automatically added).

Comment
Enter comments to be saved with the file. Up to 255 alphanumeric characters can be entered.

Save button
Saves the settings file under the specified file name on the local host.

Note
After saving a trend settings file, the saved file name and comment appears in the text box the next time you open the Save the trend settings dialog box (these items are blank if no settings have been saved previously, or when starting up the software). Also, when you select a file in the Save the trend settings dialog box, the file and comment are displayed in the input boxes at the bottom of the window. This allows you to conveniently overwrite settings.
Opening Trend Settings from a Local Host

Procedure

1. Click (the Open button) in the DataBrowser window or choose File > Open from the menu bar. The Open dialog box is displayed.

   ![Image of the Open dialog box]

   - Delete button
   - Update button
   - Drag to change the column width
   - Double-click a number to open the file

2. Select a file and click Open, or double-click the file number. The Information dialog box opens.

   ![Image of the Information dialog box]

3. Click the Yes button. The trend settings loaded from the trend settings file are displayed. Click No to close the Information dialog box.

Explanation

File List
Displays the name of the settings file and comments saved on the local host.

Delete the selected file button
Deletes the selected file.

Update button
Updates the displayed file list.

File Type
- If you select all files (.dbc; .dbv), the saved search settings files and display settings files are displayed.
- If you select Search settings file (.dbc), only the search settings files are displayed.
- If you select Trend settings file (.dbv), only the display settings files are displayed.

Open button
Opens the settings file selected in the File List. (When a trend settings file is opened, the Trend display window becomes active.) When a search settings file is opened, the Search window becomes active.

Cancel button
Closes the Open dialog box.
Opening Trend Settings indstop from a Network Host

**Procedure**

1. Click ☐ on the toolbar or choose **File > Open** from the menu bar. The Open dialog box is displayed.

2. Click the **Hosts on network** tab. The Hosts on network tab is displayed.

3. Click the **Update** button. The names of hosts running DataBrowser, and their corresponding files names and comments are displayed.

4. Select a host from the Host List. The a list of files saved on the selected host is displayed.

5. Select a file from the list that you wish to load and click **Open**, or double-click the file number. The Information dialog box opens.

6. Click the **Yes** button. The trend settings loaded from the trend settings file are displayed. Click **No** to close the Information dialog box.

**Explanation**

**Host List**
- The Host List displays the names of any hosts on the network that are running DataBrowser.

**File List**
- Displays the settings files and comments saved on the host selected in the host list.

**Host Name**
- Displays the name of the host selected in the host list.

**Update button**
- Updates the host list and file list.

**File Type, Open Button, and Cancel Button**
- See Opening Trend Settings Files from a Local Host.
3.8 Converting Data Formats

**Procedure**

1. Open the waveform display screen and display the waveforms of the data you wish to convert.

2. Select a range to convert using the cursors (if no cursors are displayed all data will be converted). Click the Data Conversion dialog box opens.

3. Select a conversion type of Excel, Text, or Lotus. To change the range of data to be converted, specify a Start and End point.

4. Enter the number of steps. (See Explanation for details.)

5. To select a channel whose interval is to be used for the interval during data conversion, select the Write Measured point of the following channel check box and click the Select button. The Selection dialog box opens. (See Explanation for details.)

6. If you click channel whose measured points are output, that channel is displayed in the Data Conversion dialog box.

7. Click the File button. The File name dialog box opens.
8. Enter a destination folder and file name and click the **OK** button.

The name of the output file appears in the Data Conversion dialog box.

9. Click the **Start** button.

![Data Conversion Dialog Box](image.png)

**Explanation**

**Conversion Type**
Excel
- Data that can be opened using Microsoft’s spreadsheet application Excel version 8.0 (Excel97) or later. The extension is .xls.

Text
- Text data with each data point separated by a comma. The extension is .txt.

Lotus
- Data that can be opened using Lotus’s spreadsheet application 1-2-3 version 2.0 or later. The extension is .wj2.

**Start and End Points**
You can select a range of data to convert. If cursors are placed in the trend display screen, the range determined by the cursors defines the start and end points. If no cursors are displayed, all the first and last data of all the data represent the start and end points. Also, the start and end times are displayed to the right of the entry boxes.

**Step Setting**
You can specify an interval for data conversion output. This area includes the setting for the number of steps, and a setting for specifying the channel whose measured points are to be output (Write Measured point of the following channel).
- If the Write Measured point of the following channel check box is not selected, the measured points of all channels assigned to the group are output, and the smallest unit interval is used as the reference interval.
- If the Write Measured point of the following channel check box is selected, the interval of the selected channel is used as the reference interval.
- By specifying the number of steps, rather than outputting all points in the range (steps = 1), you can thin the data by outputting only the points sampled at certain intervals.
3.8 Converting Data Formats

The figure below shows an example of output when the Write Measured point of the following channel check box is not selected, the smallest unit interval (reference interval) is 0.5 s, and the number of steps is 1 (if the steps were set to 3, samples would be output every 1.5 s).

Minimum unit interval (0.5s)

CH01(1.5s)  
CH02(0.5s)  
CH03(1.0s)  
CH04(2.0s)  
CH05(1.5s)  

Output (0.5 s)  
D: Measurement point of each channel

The squares represent the output of measured points on each channel (0.5 s) if the Write Measured points of the following channel check box is selected and channel 3 is also selected, measured points on each channel are output every 1 s.

Note

• If the output points are not measured points, the points directly after are output.
• When the Write Measured point of the following channel check box is selected, the start and end times on the right are those of the selected channel.

Example of the Converted Data

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>47</td>
<td>Measurement data</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>48</td>
<td>Channel</td>
<td>CH01</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>49</td>
<td>Tag No.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td>Tag Comment</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>51</td>
<td>Unit</td>
<td>V</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>52</td>
<td>Interval/Sep</td>
<td>2,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>53</td>
<td>Days</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>54</td>
<td>Time</td>
<td>Second</td>
<td>Date</td>
<td>Time</td>
<td>Second</td>
<td>Value Min</td>
<td>Value Max</td>
<td>Date</td>
</tr>
<tr>
<td>55</td>
<td>0.00211.44</td>
<td>0.000</td>
<td>2004/12/15 15:43:00</td>
<td>0.000</td>
<td>0.000</td>
<td>0.219</td>
<td>2004/12/15 15:43</td>
<td></td>
</tr>
<tr>
<td>56</td>
<td>0.00211.6</td>
<td>0.000</td>
<td>2004/12/15 15:43:00</td>
<td>0.000</td>
<td>-0.780</td>
<td>0.003</td>
<td>2004/12/15 15:43</td>
<td></td>
</tr>
<tr>
<td>57</td>
<td>0.00210.8</td>
<td>0.000</td>
<td>2004/12/15 15:43:04</td>
<td>0.000</td>
<td>-0.248</td>
<td>0.003</td>
<td>2004/12/15 15:43</td>
<td></td>
</tr>
<tr>
<td>58</td>
<td>0.00213.0</td>
<td>0.000</td>
<td>2004/12/15 15:43:00</td>
<td>0.000</td>
<td>-0.448</td>
<td>0.003</td>
<td>2004/12/15 15:43</td>
<td></td>
</tr>
<tr>
<td>59</td>
<td>0.00212.4</td>
<td>0.000</td>
<td>2004/12/15 15:43:10</td>
<td>0.000</td>
<td>-0.570</td>
<td>0.004</td>
<td>2004/12/15 15:43</td>
<td></td>
</tr>
<tr>
<td>60</td>
<td>0.00212.6</td>
<td>0.000</td>
<td>2004/12/15 15:43:12</td>
<td>0.000</td>
<td>-0.689</td>
<td>0.005</td>
<td>2004/12/15 15:43</td>
<td></td>
</tr>
<tr>
<td>61</td>
<td>0.00212.8</td>
<td>0.000</td>
<td>2004/12/15 15:43:14</td>
<td>0.000</td>
<td>-0.809</td>
<td>0.006</td>
<td>2004/12/15 15:43</td>
<td></td>
</tr>
</tbody>
</table>

Notes When Converting Data

• There is a limit to the number of data points that Excel and Lotus1-2-3 can handle. Before executing the conversion, set the channels/groups to be converted, the conversion range, and the step so that the number of data points is appropriate (see Automatic Division Function for Conversion Output Files). In addition, if the free memory space on the PC is low, you may not be able to load the data using Excel or Lotus 1-2-3.
• If you set the save destination to a storage medium that has slow access such as a floppy disk, the saving of the data may take an extended time. It is recommended that such storage medium not be selected for the save destination.
• Select a save destination with adequate free space.
Automatic Division Function for Conversion Output Files

If the number of points to be converted and output is large and you attempt to save all the points to a single file, the file will exceed the allowable number of rows in Excel or Lotus 1-2-3, making the file unloadable.

The Automatic Division function automatically creates multiple files that are within the row number limit of Excel and Lotus 1-2-3. The names of the divided files are the original file name plus an appended sequence number.

File name format: file name-****.extension (where **** is a four-digit number).
Ex. Output-0003.xls
Excel row limit: 65536
Lotus 1-2-3 row limit: 8192

Automatic division is not available for conversion to text format.
3.9 Printing Data

Printing Procedure

1. Open the waveform display screen.

2. Click (the Print button) on the toolbar or choose File > Print from the menu bar. The Printout settings dialog box opens.

![Print settings dialog box]

Enter a comment to be printed (of up to 255 alphanumeric characters)

3. Select a print range and color, and enter a print title. Click the OK button. The Print dialog box opens.

![Print dialog box]

4. Click the OK button.

Viewing a Print Preview Procedure

1. Open the trend display screen.

2. Choose File > Print Preview from the menu bar.
3.9 Printing Data

**Explanation**

You can print cursor values and statistics along with waveforms from the trend display screen. To print cursor values and waveforms, open the Cursor Value dialog box before printing. To print statistics, open the Statistics dialog box before printing. To print cursor values and statistics, open both dialog boxes before printing.

**Print Range**

Choose from Between Cursors and All. Selecting Between Cursors prints the waveforms in the cursor range displayed on the trend display screen on a single page.

**Specifying Colors**

You can select black/white print or color print.

**Print Title**

Enter a title to be printed at the top of the paper.
# Chapter 4  Troubleshooting

## 4.1 Error Messages and Corrective Actions

A message (such as an error message) may appear during operation. The following describes the meanings of the messages and their corrective actions.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>E0002</td>
<td>Insufficient memory. Please close at once.</td>
<td>Exit all other software programs and restart the OS.</td>
</tr>
<tr>
<td>E0004</td>
<td>Invalid license number. Please reinstall.</td>
<td>Reinstall the software.</td>
</tr>
<tr>
<td>E0101</td>
<td>Cannot open from the DataBrowser.</td>
<td>This software cannot be opened by itself. Start it from the DataBrowser.</td>
</tr>
<tr>
<td>E4948</td>
<td>Could not initialize communications.</td>
<td>Check whether TCP/IP is operating normally.</td>
</tr>
<tr>
<td>M4959</td>
<td>Cannot exit while DataBrowser is starting up.</td>
<td>Close DataBrowser, then shut down or log off.</td>
</tr>
</tbody>
</table>

### Search Folder Registration

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>E4925</td>
<td>No more search folders can be registered.</td>
<td>The limit of eight folders that can be registered in the search folder registration area has been reached. If you need to register a new folder, first delete one or more of the folders first.</td>
</tr>
<tr>
<td>E4940</td>
<td>Same folder ID already exists. Check the list of registered folders.</td>
<td>A folder with the same ID has already been registered in the search folder registration dialog box. Either delete the existing folder from the list, or register the new folder using a different ID.</td>
</tr>
<tr>
<td>E4957</td>
<td>Same folder ID already exists. Check the search folders.</td>
<td>Same folder ID already exists in the search folder registration area. Therefore, the new one cannot be registered. Delete the folder with the same ID from the registration area, or, register the new folder using a different ID. If registering with a different ID, use a folder ID not already listed in the registration area.</td>
</tr>
<tr>
<td>E4960</td>
<td>Limit of folders that can be registered exceeded.</td>
<td>If more than two hundred folders would be registered, registration is denied. If you need to register a new folder, first delete an existing one from the folder registration list in the search folder registration dialog box.</td>
</tr>
</tbody>
</table>

### Executing Searches

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>E4907</td>
<td>No response.</td>
<td>Check whether the network is connected correctly (cables, hubs, and other hardware), and that no problems occurred on the network.</td>
</tr>
<tr>
<td>E4939</td>
<td>Folder ID not found.</td>
<td>On the host on which the error occurred, the search could not be performed because the folder ID does not exist in the folder registration of the DataBrowser being run. Register the search folder on the DataBrowser on the host on which an error occurred.</td>
</tr>
<tr>
<td>E4942</td>
<td>Folder not found.</td>
<td>Check whether the folder exists on the DataBrowser on the host on which an error occurred.</td>
</tr>
<tr>
<td>E4945</td>
<td>Failed to write file.</td>
<td>Failed to write the search results file. Confirm that the disc capacity and file system are correct.</td>
</tr>
<tr>
<td>E4946</td>
<td>Connection failure.</td>
<td>Check whether the host on which an error occurred exists. If it exists, check whether DataBrowser is running on that host. Check whether the network is connected correctly (cables, hubs, and other hardware), and that no problems occurred on the network.</td>
</tr>
</tbody>
</table>
### 4.1 Error Messages and Corrective Actions

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>E4947</td>
<td>DataBrowser not found.</td>
<td>Software may be running on the same port (50285) used by DataBrowser. Check the host on which the error occurred.</td>
</tr>
<tr>
<td>E4956</td>
<td>The number of data files that meet the criterion exceeded the limit.</td>
<td>If the number of data files that meet the search the upper limit of 60000, narrow down your search conditions and perform the search again.</td>
</tr>
</tbody>
</table>

### Saving and Loading Settings and Search Results

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>E0211</td>
<td>Cannot write to the file.</td>
<td>Failed to save the file. Confirm that the disc capacity and file system are correct.</td>
</tr>
<tr>
<td>E0212</td>
<td>Cannot read file.</td>
<td>Confirm that a file exists, that the software supports it, and whether the file system is correct.</td>
</tr>
<tr>
<td>E0213</td>
<td>Cannot open the file.</td>
<td>Confirm that a file exists, that the software supports it, and whether the file system is correct.</td>
</tr>
<tr>
<td>E4955</td>
<td>Failed to delete file.</td>
<td>When files were deleted, one or more files could not be completely deleted.</td>
</tr>
<tr>
<td>M4959</td>
<td>No search results.</td>
<td>Since no search results files are in the data search window, search results could not be saved.</td>
</tr>
</tbody>
</table>

### Saving and Loading Settings and Search Results

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>E4961</td>
<td>Failed to copy data file.</td>
<td>Failed to copy data file. Check whether the disk capacity in the copy destination is sufficient, whether the copy destination folder is write-protected, and whether the file system is correct.</td>
</tr>
<tr>
<td>E4962</td>
<td>The copied data file exists under a different name.</td>
<td>A data file of the same name was found in the copy destination. Change the name. In this case, save the file in the copy destination under the name, “copied file name-four digit number.extension.” The four digit number starts with 0000, followed by 0001, and so on.</td>
</tr>
</tbody>
</table>
Index

<table>
<thead>
<tr>
<th>A</th>
<th>3-5</th>
</tr>
</thead>
<tbody>
<tr>
<td>adding and deleting groups</td>
<td>3-5</td>
</tr>
<tr>
<td>adding channels</td>
<td>2-16</td>
</tr>
<tr>
<td>automatic division function</td>
<td>3-26</td>
</tr>
<tr>
<td>auto zone</td>
<td>3-15</td>
</tr>
<tr>
<td><strong>C</strong></td>
<td></td>
</tr>
<tr>
<td>channel display configure screen</td>
<td>3-1</td>
</tr>
<tr>
<td>Channel Information Screen</td>
<td>3-1</td>
</tr>
<tr>
<td>channel information screen</td>
<td>3-15</td>
</tr>
<tr>
<td>clip function</td>
<td>3-19</td>
</tr>
<tr>
<td>computed results (statistics)</td>
<td>3-24</td>
</tr>
<tr>
<td>conversion type</td>
<td>3-3</td>
</tr>
<tr>
<td>copy</td>
<td>2-23</td>
</tr>
<tr>
<td>copying data files</td>
<td></td>
</tr>
<tr>
<td><strong>D</strong></td>
<td></td>
</tr>
<tr>
<td>data display function</td>
<td>1-1</td>
</tr>
<tr>
<td>data search function</td>
<td>1-1</td>
</tr>
<tr>
<td>data search window</td>
<td>2-8</td>
</tr>
<tr>
<td>data type specification</td>
<td>2-6</td>
</tr>
<tr>
<td>date and time specification</td>
<td>3-11</td>
</tr>
<tr>
<td>different intervals</td>
<td>3-8</td>
</tr>
<tr>
<td>display colors</td>
<td>3-17</td>
</tr>
<tr>
<td>displaying cursor values</td>
<td>3-9</td>
</tr>
<tr>
<td>displaying trends</td>
<td></td>
</tr>
<tr>
<td><strong>E</strong></td>
<td></td>
</tr>
<tr>
<td>editing functions</td>
<td>3-3</td>
</tr>
<tr>
<td>edit zone</td>
<td>3-14</td>
</tr>
<tr>
<td>end reference</td>
<td>3-12</td>
</tr>
<tr>
<td>error messages and corrective actions</td>
<td>4-1</td>
</tr>
<tr>
<td>executing the search</td>
<td>2-11</td>
</tr>
<tr>
<td>exiting the software</td>
<td>1-4</td>
</tr>
<tr>
<td><strong>F</strong></td>
<td></td>
</tr>
<tr>
<td>file details</td>
<td>2-14</td>
</tr>
<tr>
<td>file name specification</td>
<td>2-7</td>
</tr>
<tr>
<td>file type</td>
<td>2-18</td>
</tr>
<tr>
<td>flow of operations</td>
<td>1-5</td>
</tr>
<tr>
<td>folder ID</td>
<td>2-2</td>
</tr>
<tr>
<td>folder list</td>
<td>2-4</td>
</tr>
<tr>
<td>full zone</td>
<td>3-14</td>
</tr>
<tr>
<td><strong>G</strong></td>
<td></td>
</tr>
<tr>
<td>group name</td>
<td>3-2</td>
</tr>
<tr>
<td>group selection tabs</td>
<td>3-10</td>
</tr>
<tr>
<td><strong>H</strong></td>
<td></td>
</tr>
<tr>
<td>host list</td>
<td>2-4</td>
</tr>
<tr>
<td><strong>I</strong></td>
<td></td>
</tr>
<tr>
<td>intersection between waveform and cursor</td>
<td>3-13</td>
</tr>
<tr>
<td><strong>K</strong></td>
<td></td>
</tr>
<tr>
<td>keyword specification</td>
<td>2-9</td>
</tr>
<tr>
<td><strong>L</strong></td>
<td></td>
</tr>
<tr>
<td>linked group settings</td>
<td>3-5</td>
</tr>
<tr>
<td><strong>M</strong></td>
<td></td>
</tr>
<tr>
<td>minimum and maximum values of scale</td>
<td>3-7</td>
</tr>
<tr>
<td>multi-zone</td>
<td>3-15</td>
</tr>
<tr>
<td>multiple search conditions</td>
<td>2-10</td>
</tr>
<tr>
<td><strong>N</strong></td>
<td></td>
</tr>
<tr>
<td>normal format indstop and indstart MinMax format</td>
<td>3-13</td>
</tr>
<tr>
<td><strong>O</strong></td>
<td></td>
</tr>
<tr>
<td>Opening Search Results</td>
<td>2-22</td>
</tr>
<tr>
<td>opening search results</td>
<td>2-21</td>
</tr>
<tr>
<td>Openning Search Settings</td>
<td>2-19</td>
</tr>
<tr>
<td>opening search settings</td>
<td>2-18</td>
</tr>
<tr>
<td>opening trend settings</td>
<td>2-31</td>
</tr>
<tr>
<td>overview of DataBrowser</td>
<td>1-1</td>
</tr>
<tr>
<td><strong>P</strong></td>
<td></td>
</tr>
<tr>
<td>paste</td>
<td>3-3</td>
</tr>
<tr>
<td>printing data</td>
<td>3-27</td>
</tr>
<tr>
<td><strong>S</strong></td>
<td></td>
</tr>
<tr>
<td>saving search results</td>
<td>2-20</td>
</tr>
<tr>
<td>saving search settings</td>
<td>2-17</td>
</tr>
<tr>
<td>search conditions</td>
<td>2-6</td>
</tr>
<tr>
<td>search folders</td>
<td>2-2</td>
</tr>
<tr>
<td>search paths area</td>
<td>2-2</td>
</tr>
<tr>
<td>search results</td>
<td>2-12</td>
</tr>
<tr>
<td>search within results</td>
<td>2-13</td>
</tr>
<tr>
<td>serial number specification</td>
<td>2-9</td>
</tr>
<tr>
<td>settings in the channel setup screens</td>
<td>3-6</td>
</tr>
<tr>
<td>showing channel details</td>
<td>3-8</td>
</tr>
<tr>
<td>slide zone</td>
<td>3-14</td>
</tr>
<tr>
<td>software license</td>
<td>ii</td>
</tr>
<tr>
<td>sort function</td>
<td>2-13</td>
</tr>
<tr>
<td>specifying pages</td>
<td>2-13</td>
</tr>
<tr>
<td>start and end points</td>
<td>3-24</td>
</tr>
<tr>
<td>starting the software</td>
<td>1-4</td>
</tr>
<tr>
<td>start reference</td>
<td>3-12</td>
</tr>
<tr>
<td>status (right)</td>
<td>2-11</td>
</tr>
<tr>
<td>step setting</td>
<td>3-24</td>
</tr>
<tr>
<td>subfolders</td>
<td>2-10</td>
</tr>
<tr>
<td>system requirements</td>
<td>1-3</td>
</tr>
<tr>
<td><strong>T</strong></td>
<td></td>
</tr>
<tr>
<td>time axis display area</td>
<td>3-10</td>
</tr>
<tr>
<td>time reference</td>
<td>3-12</td>
</tr>
<tr>
<td>time reference mode</td>
<td>3-12</td>
</tr>
<tr>
<td>toolbar</td>
<td>3-2</td>
</tr>
<tr>
<td>trend display window</td>
<td>3-1</td>
</tr>
<tr>
<td>trend settings</td>
<td>3-20</td>
</tr>
<tr>
<td>trigger reference</td>
<td>3-12</td>
</tr>
<tr>
<td>trip point</td>
<td>3-16</td>
</tr>
<tr>
<td>trip points</td>
<td>3-7</td>
</tr>
</tbody>
</table>
Index

U
user zone ........................................................................ 3-13

V
viewing a print preview .................................................. 3-27

W
waveform display area .................................................. 3-10
waveform display screen ............................................... 3-4
waveform display zones ............................................... 3-7

Y
Y-axis display ................................................................. 3-13